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Проектирование и моделирование печатных 
плат в САПР Allegro
Часть 4

В третьей части статьи было описано, как перейти от схемы устройства 

к печатной плате, создать её контур, выбрать посадочные места, 

разместить компоненты, выполнить трассировку проводников и вывести 

производственные файлы.

В данной, заключительной части статьи описывается порядок 

трассировки, проверки и вывода производственных файлов.

Рис. 27. Окно задания опций для трассировки Рис. 28. Выбор подходящего типа переходных отверстий для трассировки

Александр Панов (Москва)

ТРАССИРОВКА

После размещения компонентов 

и задания правил можно приступать 

к трассировке. В Allegro можно поль-

зоваться как ручной трассировкой, так 

и автоматической. Обычно критиче-

ские цепи разводятся вручную, затем 

они фиксируются, и автоматом трасси-

руется всё остальные, но это зависит от 

предпочтений пользователя.

РУЧНАЯ ТРАССИРОВКА

Маршрут ручной трассировки имеет 

приблизительно следующий вид:

 ● задание границ платы, используемых 

переходных отверстий и сеток;

 ● заливка полигонами земли и питания;

 ● выполнение Fanout (коротких сое-

динений контактных площадок 

с переходными отверстиями), про-

верка их подключения к полигонам 

питания;

 ● трассировка остальных цепей с ис-

пользованием ручных инструментов;

 ● оптимизация проложенных провод-

ников;

 ● проверка на ошибки.

Выберем Display > AssignColors и назна-

чим цвет для цепи VPP в окне Options 

(справа). Затем перейдём в закладку 

Find и переключимся на поиск цепей 

(Net) в разделе Find By Name, нажмём 

More… и перенесём в правое окно цепь 

VPP. После нажатия Apply все площад-

ки и связи, принадлежащие этой цепи, 

должны окраситься в выбранный цвет. 

Можно перекрасить, не прерывая выпол-

нения команды, и остальные цепи, кото-

рые мы захотим выделить.

После этого выполним команду 

Route > Connect (можно вызвать нажа-

тием F3 или кликом на иконку  ), ука-

жем необходимые параметры про-

водников в панели Options (справа) 

и выполним трассировку отмеченных 

цепей (см. рис. 27).

Нам не обойтись без переходных 

отверстий. Их можно выбрать в редак-

торе ограничений (Constraint Manager, 

CM). Перейдём в нём в закладку Physical 

и найдём столбец Via. Выполним 

нажатие левой кнопкой мыши (ЛКМ) 

в ячейке для набора Default – откро-

ется окно выбора переходных отвер-

стий (см. рис. 28).

Слева будут отверстия, доступные из 

библиотек Allegro, справа – используе-

мые в проекте в качестве переходных 

отверстий. Найдём что-нибудь под-

ходящее, задав фильтр буквами VIA, 

а затем перенеся пад-стек двойным 

нажатием ЛКМ в окно справа. Нажмём 

ОК и выйдем из CM. Теперь при трас-

сировке, при двойном нажатии ЛКМ 

или при выполнении команды правой 

кнопкой мыши (ПКМ) > Add Via, будет 

происходить установка переходного 

отверстия. Если у вас будет несколь-

ко доступных вариантов, то переклю-

чаться между ними можно будет в окне 

Options. Результаты предварительной 

трассировки и перестановки некото-

рых компонентов можно увидеть на 

рисунке 29.

ДОБАВЛЕНИЕ ПОЛИГОНОВ

Мы проложили единичные провод-

ники. Теперь добавим цепи пита-

ния и «земли». Для этих цепей луч-

ше использовать полигоны, так как 

это, например, позволяет уменьшить 
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плотность тока и даёт экранирующий 

эффект.

Для создания контура полигона 

можно использовать в качестве осно-

вы геометрию края платы. Это особен-

но удобно, когда плата имеет сложную 

форму. Для этого активируем команду 

Shape > Copy Shape. Обратим внимания 

на панель Options (см. рис. 30) – там 

нужно указать, в каком слое будет нахо-

диться новый полигон. Отметим так-

же пункт Create Dynamic Shape и выбе-

рем Contract c расстоянием 0,5. Послед-

нее означает, что новый полигон будет 

«ужат» на 0,5 мм со всех сторон. После 

этого выполним щелчок ЛКМ на грани-

це платы – должен появиться полигон 

в выбранном слое  (см. рис. 31).

Теперь осталось назначить полиго-

ну цепь. Перейдём в режим редактиро-

вания полигонов нажатием на кноп-

ку  в панели инструментов, либо 

нажав на название текущего режима 

в строке состояния в самом низу стра-

ницы и выбрав там Shape Edit. Выделим 

полигон нажатием ЛКМ, затем откро-

ем меню нажатием на нём ПКМ. В меню 

найдём команду Assign Net. Активиру-

ем её, а затем в её настройках, нажав 

на многоточие, найдём и выберем цепь 

«земли» – 0. Нажатием ПКМ > Done 

завершим команду.

Теперь в ручном режиме нарисуем 

полигон цепи VPP. Для этого выпол-

ним Shape > Polygon и вновь обратим-

ся к настройкам команды (см. рис. 32).

После того как всё будет настрое-

но соответствующим образом, нач-

нём рисовать полигон. В итоге он дол-

жен покрывать все переходные отвер-

стия и контактные площадки цепи VPP. 

После его завершения может получиться 

так, что он не будет заполнен медью, так 

как в том месте уже есть полигон «зем-

ли». Тогда, выделив полигон питания, 

выполним ПКМ > Raise Shape Priority. 

После этого его приоритет будет увели-

чен, и полигон будет заполнен в первую 

очередь. Для того чтобы настроить пара-

метры связи полигонов с площадками, 

нужно перейти в Shape > Global Dynamic 

этих частей можно создать дублирую-

щий полигон на верхнем слое и связать 

их дополнительными переходными 

отверстиями (см. рис. 34), используя уже 

рассмотренные инструменты. Отвер-

стия можно ставить, используя коман-

ду Connect, либо копируя имеющиеся 

отверстия, нажимая на них ПКМ > Copy.

ПРОВЕРКА И ОТЧЁТЫ 
ПО ТОПОЛОГИИ

Когда все цепи разведены, можно 

выполнять проверку и формировать 

отчёты.

1. Check > Design Status. Вы увидите 

краткую информацию о проекте – 

Рис. 29. Результат предварительной трассировки

Рис. 31. Полигон в слое BOTTOM

Рис. 30. Опции для копирования полигона 

в новый слой с уменьшением размеров

Рис. 33. Вид слоя Bottom после создания 

полигонов

Рис. 34. Итоговая топология слоёв Top и Bottom

Рис. 35. Окно отображения статуса проекта

Рис. 32. Настройки команды создания полигона

Parameters… Там на закладке Thermal 

Relief Connections можно выбрать вид 

контакта для сквозных и планарных 

контактных площадок или переход-

ных отверстий, указать минимальное 

и максимальное количество перемы-

чек и их ширину. Внешний вид полу-

чившегося нижнего слоя платы пока-

зан на рисунке 33.

Видно, что полигон «земли» оказался 

разбит на две части. Для лучшей связи 
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зелёные флаги покажут, что оши-

бок нет (см. рис. 35). Красные или 

жёлтые флаги говорят об ошибках. 

Нажав на них, можно узнать, в чём 

причина. Кнопки Update to Smooth 

и Update DRC обновляют полигоны 

и информацию об ошибках.

2. Export > Quick Reports > Summary 

Drawing Report. Этой командой мы 

создадим общий отчёт о графиче-

ских объектах на плате.

3. Export > Reports. Отроется ещё один 

список отчётов. Перенеся название 

Component Report в нижнее окно 

двойным нажатием ЛКМ, а затем 

нажав Generate Reports, мы полу-

чим отчёт о положениях, названи-

ях и номиналах всех компонентов.

Есть множество вариантов отчётов 

и возможностей их настройки. Более 

подробно об этом можно узнать из дру-

гих учебных материалов.

ПОСТОБРАБОТКА

Приведём некоторые общие инстру-

менты, которые могут понадобиться 

после завершения работы с топологией.

Переименование компонентов 

вручную

Используя меню Setup > Colors, пога-

сим отображение всего, кроме следу-

ющих слоёв: Geometry\Design_Out-

line, Geometry\Assembly_Top, RefDes\

Assembly_Top и Pin\Top. Активируем 

команду Edit > Text и выберем пози-

ционное обозначение, которое хотим 

изменить. Его значение появится 

в командной строке, там же его можно 

будет переписать, а затем нажать Enter 

для подтверждения. Если вы попробу-

ете изменить позиционное обозначе-

ние на уже существующее, то его заме-

на произойдёт и у другого компонен-

та, чьё обозначение вы использовали. 

Например, имея на плате резистор R6, 

мы попробуем поменять название R5 

на R6, тогда первоначальный R6 авто-

матически станет R5.

Переименование компонентов 

автоматически

Обычно принято пронумеровывать 

компоненты, исходя из их положения 

на схеме, но если в этом отношении вас 

ничто не ограничивает, можно прону-

меровать их в зависимости от поло-

жения на плате. Для этого выполним 

команду Manufacture > Auto Rename 

Refdes > Rename (см. рис. 36).

Выберем Use Default Grid, а затем 

нажмём на кнопку More… В открыв-

шемся окне настроек (см. рис. 37) мож-

но выбрать, на каких слоях и в каком 

порядке проводить перенумерацию. 

Можно добавить префиксы, отдель-

ные для компонентов на верхнем или 

нижнем слое, либо обойтись без них, 

как мы и сделаем. Также отметим пункт 

Preserve Current Prefixes, сохранив теку-

щие буквенные обозначения. Нажмём 

Close, сохранив изменения, и запустим 

процедуру переименования нажатием 

Rename в предыдущем окне. Редактор 

плат выполнит её. При этом статус мож-

но будет увидеть в командной строке, 

а результат – на плате.

Обратная аннотация

При работе с печатной платой могут 

быть выполнены различные изме-

нения, которые необходимо учесть 

в электрической схеме. Это может быть, 

например, перенумерация компонен-

тов или свопирование выводов. Что-

бы синхронизировать после этого схе-

му с платой, нужно выполнить обрат-

ную аннотацию. Для этого в OrCAD 

Capture выделим в дереве проекта его 

название headphone.dsn, затем перей-

дём в Tools > Back annotate – откроется 

окно с настройками (см. рис. 38).

Выберем закладку PCB Editor и отме-

тим пункт Generate Feedback Files, если 

это ещё не сделано.

Не забудьте убедиться, что указан вер-

ный файл конфигурации allegro.cfg. Он 

должен находиться по адресу: <папка 

установки программы>\tools\capture\

allegro.cfg. Также укажите правильный 

путь для расположения новых файлов 

списков цепей.

Рис. 36. Автоматическое переименование 

компонентов

Рис. 37. Окно настройки автоматического переименования компонентов на плате

Рис. 38. Окно обратной аннотации в OrCAD Capture
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Помимо всего будет создан swp-

файл, в котором будут перечислены 

сделанные в топологии изменения, 

необходимые к аннотации в схему. 

Для него также нужно указать распо-

ложение. Больше информации о swp-

файле можно прочитать в OrCAD 

Capture User Guide. В нашем приме-

ре он будет называться headphone.

swp и находиться в папке headphone\

allegro.

Выделим, если это ещё не сдела-

но, пункт Update Schematic для того, 

чтобы в наш проект был выполнен 

перенос информации из swp-файла 

с помощью обратной аннотации. 

Если мы хотим увидеть содержимое 

swp-файла после его генерации, отме-

тим пункт View Output. После нажа-

тия на кнопку OK программа спросит 

нас о сохранении проекта перед про-

ведением аннотации. Соглашаемся. 

OrCAD Capture создаст новые файлы 

списков цепей (PSTCHIP.DAT, PSTXPRT.

DAT, PSTXNET.DAT) и swp-файл, кото-

рый будет открыт в отдельном окне, 

а в схему будут внесены перечислен-

ные изменения.

Прямая аннотация

С тем же успехом можно вносить сде-

ланные в схеме изменения в готовую 

или частично выполненную тополо-

гию. Для этого в дереве проекта выде-

лим основной файл headphone.dsn 

и перейдём в Tools > Create Netlist 

(см. рис. 39).

Отмечаем пункт Create or Update 

PCB Editor Board (Netrev), а в его опци-

ях указываем входной файл текущей 

топологии (в первой строке, Input 

Board File) и выходной файл (во вто-

рой строке, Output Board File). Это 

может быть один и тот же файл. Нажи-

маем OK. Будут созданы новые фай-

лы списков цепей и открыта тополо-

гия с внесёнными изменениями. После 

множественных изменений бывает 

такое, что когда мы указываем один 

и тот же файл как входной и выход-

ной, изменения не загружаются в пла-

ту. В таком случае стоит использовать 

более длинный путь. Для начала сге-

нерировать только файлы списков 

цепей, а затем загрузить их в PCB 

Designer через команду File > Import > 

Logic (см. рис. 40).

«Горячая» связь между схемой 

и платой

OrCAD Capture и Allegro PCB Designer 

тесно связаны между собой, что позво-

ляет в реальном времени следить за рас-

положением и группировкой компо-

нентов. Выделяя компоненты в одной 

программе, вы тут же видите их во 

второй. Обычно эта связь работает по 

умолчанию. Если нет, то необходимо 

произвести несложную настройку.

1. В редакторе OrCAD Capture выделим 

файл проекта headphone.dsn.

2. Перейдём в Options > Preferences.

3. Выберем закладку Miscellaneous.

4. Найдём и отметим пункт Enable 

Intertool Communication.

5. Кликнем ЛКМ на OK.

6. Убедимся, что в топологию загруже-

на последняя версия списка цепей.

Рис. 39. Окно генерации нетлиста для внесения изменений в плату Рис. 40. Окно загрузки списка цепей в редакторе Allegro PCB Editor

Рис. 41. Динамическая связь между схемой и топологией: 

а – выделение компонента на схеме; б – подсветка компонента в топологии

а б
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После этого, например, выделив кон-

денсатор на схеме, мы увидим его под-

светку и в топологии (см. рис. 41).

Аналогично и в топологии: выпол-

нив щелчок ПКМ > Highlight на нуж-

ном компоненте и выбрав любой 

вид подсветки, мы, тем самым, выде-

лим его и на схеме. Если же нам нуж-

но погасить все выделенные компо-

ненты, выберем Display > Dehighlight 

и в настройках команды (справа) 

нажмём кнопку All.

СОЗДАНИЕ ВЫХОДНЫХ ФАЙЛОВ

Последней задачей при разработ-

ке печатной платы является создание 

файлов для передачи заводу-изготови-

телю, отделу комплектации и монтаж-

ному участку. Для этого могут понадо-

биться Gerber-файлы c информацией 

о рисунке слоёв, файлы сверловки фор-

мата Excellon NC, DXF-файлы для созда-

ния чертежей, файлы формата IPC2581, 

ODB++ или файлы для печати на прин-

тере. Сгенерировать их можно через 

закладку меню Export.

Перед созданием выходных файлов 

стоит лишний раз убедиться в отсут-

ствии ошибок.

Генерация Gerber-файлов

1. Выполним Export > Gerber Parameters 

(см. рис. 42).

2. Выберем формат Gerber RS274X, наи-

более часто используемый сейчас 

при производстве.

3. Выберем по пять знаков до и после 

запятой в координатах объектов 

(Integer Places и Decimal Places).

4. Можно указать дополнительный 

текст, который будет добавляться 

к названию файлов Gerber в начале 

и конце (Prefix и Suffix). Например, 

название проекта.

5. Пункты Leading и Trailing Zeroes 

отбрасывают при генерации незна-

чащие нули до и после запятой. 

Нужно стараться сохранять один 

вид этих настроек для всех выход-

ных файлов, чтобы не возникало 

сбоев.

6. Убедимся, что единицы измерения – 

миллиметры, и сохраним измене-

ния (OK).

7. Перейдём в Setup > Colors и погасим 

все слои, нажав Off в Global Visibility.

8. В закладке Stack-Up отобразим слой 

Soldermask_Top для Pin.

9. В закладке Geometry отобразим все 

слои Soldermask_Top.

10. Перейдём в Export > Gerber. В окне 

со списком файлов нажмём ПКМ на 

одном из них и выберем Add, доба-

вив новый. Назовём его SM_TOP. 

Тем самым мы создали Gerber-файл 

с информацией о защитной плён-

ке на верхней стороне. Если мы рас-

кроем список слоёв, которые пой-

дут в этот файл, то увидим только 

те, которые отображены в данный 

момент на экране.

11. Повторим эти шаги для того, что-

бы создать Gerber-файл SP_TOP 

с информацией о паяльной пасте 

на верхней стороне. Для этого 

используем слои Pastemask_Top/

Pin и Package Geometry/Pastemask_

Top.

12. Также не забудем слой BRD с грани-

цей платы (Board Geometry/Design_

Outline). Для него справа укажем 

параметр Undefined Line Width, 

равный 0,1 мм, потому что граница 

задана полигоном с нулевой шири-

ной линии (иначе она будет проиг-

норирована при выводе).

13. Выберем все Gerber-файлы, нажав 

Select All, и создадим их нажатием 

на Create Artwork (см. рис. 43).

Созданные Gerber-файлы мож-

но посмотреть в программе CAM350 

или аналогичной. Они будут иметь 

вид, представленный на рисунке 44а. 

Также можно посмотреть создан-

ные файлы в самом редакторе Allegro 

PCB Editor, втянув их командой File > 

Import > Artwork в специально соз-

данные для этого новые слои в клас-

се Manufacturing.

Рис. 42. Окно параметров для вывода файлов Gerber 

для производства Рис. 43. Окно вывода файлов Gerber с подготовленными группами слоёв
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Вывод информации об отверстиях

Создадим в файле топологии пере-

чень используемых отверстий (Drill 

Legend). Отобразим на экране всю 

информацию, имеющуюся в проекте 

(закладка Visibily > Global Visibility > 

ON). В меню Manufacture > Create Drill 

Table, ничего не меняя, нажмём OK 

и поместим таблицу на экране щелч-

ком ЛКМ.

Теперь создадим файл сверловки. 

Перейдём в меню Export > NC Drill. 

В открывшемся окне и в окне, появ-

ляющемся после нажатия кнопки NC 

Parameters (см. рис. 45), настроим всё 

в соответствии с настройками, кото-

рые использовали при выводе Gerber-

файлов.

В итоге, после закрытия окна NC 

Parameters и нажатия кнопки Drill, мы 

получим файл с координатами и пара-

метрами отверстий.

Для проверки мы добавили его 

к ранее созданным Gerber-файлам в 

сторонней программе (см. рис. 44б).

Всё совпало, вывод закончен ус-

пешно.

Также просмотр можно выпол-

нить средствами Cadence. Для этого 

создадим новый файл платы (File > 

New), тип Board, название, например, 

Artwork. Перейдём в меню Setup > 

More > Subclasses. В нём зайдём в класс 

Manufacturing и добавим новый под-

класс Artwork.

Согласимся со всеми настройками, 

нажав OK, а затем выполним импорт 

Gerber-файла (Import > More > Artwork). 

Укажем класс Manufacturing и подкласс 

Artwork, нажав «…». Найдём любой из 

созданных Gerber-файлов, выберем его 

и нажмём кнопку Load File. У нас поя-

вится контур будущего объекта. Поста-

вим его на любое место. Эту последова-

тельность действий можно выполнить 

для всех файлов, которые вы хотите 

просмотреть.

На этом знакомство с маршру-

том проектирования Cadence Allegro 

и OrCAD можно считать законченным. 

Мы создали схему, промоделировали её, 

создали печатную плату и вывели фай-

лы для производства. 

Более подробную информацию по 

функциям САПР можно получить на 

сайте PCB SOFT или на канале ком-

пании в Youtube.

Рис. 44. Просмотр выведенных файлов 

Gerber (а) и Drill (б) в сторонней программе

Рис. 45. Настройка вывода файлов сверловки: 

а – настройка параметров вывода; б – настройка 

формата файла сверловки
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Подержанные 
IoT-устройства требуют 
особой защиты

Как обычно выглядит сделка по прода-

же подержанного автомобиля? Продавец 

и покупатель подписывают договор, поку-

патель передаёт или перечисляет день-

ги, получает ключи от машины и уезжа-

ет. Чем будет отличаться сделка по про-

даже т.н. подсоединённого автомобиля? 

Глава подразделения X-ForceRed в IBM 

Security Чарльз Хендерсон небезоснова-

тельно отмечает, что у продавца могут 

сохраниться возможности удалённого 

доступа к проданной машине.

Проблема, по его словам, заключается 

в том, что, будучи новым, автомобиль был 

поставлен на сервисное обслуживание, 

а значит к нему был организован доступ 

посредством некоего мобильного приложе-

ния, связанного с неким облачным реше-

нием. И если пользователь может уда-

лить мобильное приложение, то с облач-

ной частью всё куда сложнее: возможность 

удалить её или реорганизовать доступ к ней 

ему недоступна. Для этого требуются уси-

лия сервис-центра. IBM Security уже удалось 

обнаружить уязвимости в системах отзы-

ва прав доступа к автомобилям и «умной» 

бытовой электроники. Хендерсон отме-

тил, что это носит «повсеместный» харак-

тер и что он стремится привлечь внима-

ние к проблеме.

Задачу организации управления облач-

ной частью IoT он считает непростой по ряду 

причин: «Вторичный рынок уже не прино-

сит вендору прибыли, поэтому у него нет 

стимула защищать второго владельца 

IoT-устройства. Я не утверждаю, что управ-

ление идентификацией решит все пробле-

мы, но мы ещё очень мало сделали для 

защиты бытовой электроники».
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